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Dossier  

Mesures d’intervalles, méthodologie  
et pratique∗ 
AMINE BEYHOM ** 

Introduction générale 
Le monde de l’ethnomusicologie et de la musicologie analytique est, de manière 
quasi permanente, confronté à l’utilisation d’échelles sortant du cadre du 
tempérament égal et du système intervallique de la musique tonale. Ces échelles 
forment souvent système, et sont quelques fois théorisées de manière 
exhaustive 1 ; reste que leur identification ainsi que l’étude de variations d’ordre 
intonationel en leur sein sont difficiles, et nécessitent dans la majorité des cas 
des mesures permettant de mieux décrire (« transcrire ») l’évolution du contour 
mélodique dans le temps. 

On pourrait croire que, pour des musiciens ou des musicologues habitués à des 
tempéraments « exotiques » ou formés à un système mélodique fortement non 
tempéré, l’identification à l’oreille des intervalles utilisés dans des musiques 

 

 
* Ce dossier est une synthèse de recherches de l’auteur sur les échelles de musiques traditionnelles, et d’un 
cours et de séminaires de formation aux mesures d’intervalles à l’Université Antonine et à l’université Paris 
Sorbonne, Paris IV en 2007. 
** Professeur associé de musicologie à l’Institut Supérieur de Musique de l’Université Antonine – Baabda 
(Liban), chercheur associé au Centre de Recherche « Langages Musicaux » de l’Université Paris Sorbonne - 
Paris IV. 
1 Cf. Beyhom, 2003. 
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non familières et également non tempérées serait relativement aisée : ceci est 
loin d’être le cas, la tendance « naturelle » étant de ramener les hauteurs et 
intervalles non familiers au schéma intervallique et musical le plus usité par 
l’analysant ; ce phénomène a été constaté par l’auteur dans le cadre de cours 
donnés à l’université antonine au Liban, à des étudiants de niveau master 2 en 
musicologie 2, qui ont identifié des échelles modales de musiques non familiè-
res 3 avec des échelles courantes de la musique arabe ce qui, après vérification, 
s’est avéré erroné 4.  

Ce processus d’identification « à l’oreille » est, par conséquent, à proscrire dans 
toute analyse mélodique à prétention scientifique 5, et son utilisation systémati-
que dans, par exemple, les transcriptions des « folkloristes » européens des deux 
siècles précédents 6, met ces dernières sérieusement en question, plus particuliè-
rement en ce qui concerne les musiques à voix nue ou accompagnées unique-
ment de percussions ; dans ce dernier cas, en effet, les évolutions éventuelles de 
la fondamentale (du « diapason »), les variations au sein de l’échelle ainsi que 
les modulations possibles rendent extrêmement aléatoire une transcription fidèle 
à l’original, surtout pour des musicologues formés (à la base) à des tempéra-
ments fixes (ou quasiment) et habitués à des interprétations (relativement) 
standardisées. Dans le cas de musique instrumentale ou mixte, le « diapason » 
(les notes « fixes ») demeurant relativement stable(s) 7, l’analyse devient plus 
aisée mais la difficulté demeure quant à la détermination des intervalles exacts 

 

 
2 Dont certains diplômés en études instrumentales ou en chant au Conservatoire Supérieur National de 
Musique - Liban. 
3 En l’occurrence, de musique bretonne. 
4 Cette tendance à « ramener » l’existant vers le familier (ou le reconnaissable) existe, évidemment, aussi en 
ce qui concerne les rythmes : dans une séance de répétitions à Royaumont, dans le cadre des concerts 
parallèles au colloque « maqâm et création », un rythme tadjik a été identifié, par divers musiciens et musico-
logues présents, comme un « 13/8 » ; une analyse minutieuse rythmico-métrique a permis de démontrer que, 
en cas d’hypothèse sur l’existence de battements isochrones, cette appréciation était loin de la réalité, les 
rapports temporels au sein du cycle rythmique évoluant avec le temps [cf. Beyhom, 2005]. 
5 Sauf dans le cas trivial où on analyse une musique d’un répertoire familier dans un système intervallique 
stable ou fixe, comme par exemple le système tempéré égal à 12 demi-tons, au sujet duquel Mark Lindley  
(2001, p. 248) précise qu’il est « le tempérament standard en Occident aujourd’hui, sauf parmi les spécialistes 
de musique ancienne » [traduit de l’anglais]. 
6 Bien obligés de se contenter des outils existants à l’époque … 
7 Mais pouvant évoluer (généralement en montant) quand les instruments, notamment à vent, « chauffent » : 
ce processus prend un certain temps, mais il arrive que deux phrases musicales (instrumentales ou vocales) 
analysées à quelques dizaines de secondes d’intervalle montrent un déplacement de la fondamentale, ce qui 
n’est pas rédhibitoire dans le cas où les proportions intervalliques restent cohérentes (homothétiques). 
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des échelles utilisées, même dans le cadre d’instruments « discrets » 8 si le 
tempérament de ces derniers s’éloigne du tempérament égal 9 ; à cela vient 
également s’ajouter le phénomène d’hétérophonie, courant en musiques popu-
laires ou extra-européennes, qui rend d’autant plus malaisée une identifica-
tion/discrimination correcte des intervalles utilisés. 

A ce stade, il est peut-être utile d’expliquer pourquoi cet article a pour titre 
« Mesures d’intervalles », et non pas « Mesures de hauteurs » ? La réponse est 
simple pour tout ceux qui sont familiarisés avec l’analyse de musiques non 
standardisées, et est contenue implicitement dans les paragraphes précédents ; 
mesurer des intervalles, et pas des hauteurs (de « notes », ou de « degrés »), 
devient indispensable dès qu’un instrument mélodique (y compris la voix) : 

• n’est pas nécessairement accordé sur une « tonique » calée sur un dia-
pason quelconque (le la à 438-442 Hz), 

• est joué de manière à ce que les intervalles utilisés sortent du cadre du 
tempérament égal sur grille de 12 demi-tons à l’octave ou de tout autre 
tempérament (ou division de l’octave) facilement identifiable par 
l’analysant, et ce d’autant plus s’ils sont variables et/ou fluctuants 10. 

Ces conditions (non exhaustives) se retrouvent presque toujours dans les 
analyses de musiques décrites comme étant « de tradition orale » et/ou 
« populaires », mais également pour des musiques d’« art » ou « savantes » 
extra-européennes 11, qu’elles soient « sacrées » ou « profanes ». Il devient 
évident que la mesure de « hauteurs » est, dans ce genre de cas, insuffisante 
pour une meilleure compréhension de l’évolution mélodique si elle n’est pas 
associée à la mesure des intervalles constitutifs de la mélodie, que ce soit par 
rapport à une tonique, à tout degré stable dans ses répétitions, ou encore par 
rapport aux hauteurs conjointes (précédente et suivante). 

 

 
8 Les catégories d’instruments discrets et continus, ou encore semi-discrets, etc., ont été explicitées par 
l’auteur dans la thèse [Beyhom, 2003] : en résumé, les instruments discrets sont des instruments mélodiques à 
intervalles fixes ou délimités (guitare, piano, instruments frettés ou à clavier en général, ou à pistons pour les 
instruments à vent), tandis que les instruments continus permettent l’exécution d’intervalles variables dans 
une même phrase mélodique (à l’exemple de la voix, du violon, du ūd, etc.) ; cette catégorisation avait déjà 
été effectuée par Frédéric Lagrange dans sa thèse sur la musique égyptienne de la Nahd ā [Lagrange, 1994]. 
9 Ou si les instruments sont accordés de manière « non traditionnelle » (ou tout simplement « mal » accordés). 
10 Comprendre par « variables » que les intervalles utilisés ne sont pas les mêmes selon l’évolution de la 
mélodie (ce procédé ressort de la structure même de la musique performée – exemple : une modulation 
quelconque), et par « fluctuants » que les degrés de l’échelle peuvent « bouger » selon le « toucher » d’un 
musicien (sur la touche du ūd, par exemple) ou la volonté du performeur. 
11 Sinon européennes, en revenant plus au registre populaire et en rappelant que les musiques d’« art » 
peuvent également être de tradition orale. 
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Une autre raison pour favoriser la mesure d’intervalles (ou plutôt la déduction 
d’intervalles) plutôt que de hauteurs trouve sa justification dans les mesures à 
l’aide de logiciels dédiés, dont nous parlerons plus longuement en fin de 
première (et dans la deuxième) partie de cet article. 

Pour notre démonstration, le corps de l’article sera divisé en deux parties, la 
première revoyant les techniques usuelles de mesure pratiquées de nos jours 12, 
et la deuxième étant consacrée à la méthodologie appliquée aux mesures à 
l’aide de logiciels spécialisés, ici sur l’exemple du logiciel Praat 13 ; cette 
deuxième partie peut également servir de manuel d’apprentissage rapide de 
l’utilisation de ce logiciel (commandes et commentaires listés en notes de bas 
de page) sur des exemples précis, tirés de musiques bretonnes et de la région de 
diffusion du maqām, mais sa finalité est, avant tout, l’établissement d’une 
méthodologie de mesures limitant les erreurs de manipulation de logiciel d’un 
côté, et, d’un autre côté, de donner quelques lignes directrices pour l’analyse 
mélodique couplée à l’utilisation d’un logiciel de mesure de hauteurs (ou 
d’intervalles). En effet, et sachant que toute mesure d’intervalle est déjà une 
analyse musicale 14, en réduisant les erreurs sur le processus de mesure en tant 
que tel, et en explicitant les choix effectués (fréquences-bornes d’analyse, 
méthode de mesure – par segment ou ponctuelle, choix de la « tonique » dans le 
cas d’une détermination d’échelle, etc.), la discussion sur une éventuelle 
interprétation des résultats et des prémisses ou processus d’analyse qui l’ont 
conditionnée devient, pour le moins, plus aisée. 

Enfin, rappelons que le but de ces méthodologies est, avant tout, de fournir aux 
analysants une méthode pratique, relativement sûre et rapide, de relever et 
analyser des intervalles pour des musiques, avant tout et en l’état actuel de la 
technologie disponible, monodiques 15 ; un complément est prévu, concernant 
l’analyse suivant cette méthodologie de certaines musiques non monodiques 16, 
 

 
12 Et connues de l’auteur, qui ne peut prétendre à l’exhaustivité. 
13 « Voix » en néerlandais : ce logiciel freeware s’est avéré, selon mon expérience, comme très performant 
dans le domaine des mesures de hauteur, et est accessible gratuitement ; des précisions supplémentaires sont 
données en annexe quant aux auteurs et aux algorithmes utilisés, ainsi que sur la procédure de test appliquée 
par l’auteur pour vérifier la cohérence des résultats (cf. également note n° 34). 

14 Tout comme toute transcription (une des finalités de la mesure d’intervalles) est déjà, en soi, une analyse. 
15 Cf. note suivante. 
16 Des séminaires de formation en mars 2007, pour étudiants et doctorants de l’université Paris Sorbonne, 
Paris IV, ont porté notamment sur des analyses de chant accompagné de guitare, ainsi que sur des monodies à 
appuis fluctuants comportant des variations homothétiques des intervalles : ces dernières analyses nécessitent 
un bagage méthodologique (et des précautions dans l’interprétation des résultats) accru(s), et sortent du cadre 
de ce premier dossier. 
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la quantification ainsi que la validation statistiques de mesures effectuées pour 
un chant (avec plusieurs couplets supposés être comparables, sinon identiques, 
sur le plan mélodique), et la possibilité d’étendre ce type de validation à un 
répertoire donné ; ce complément devrait être publié à une date (ou au sein 
d’une édition) ultérieure (de la revue). 

Ie partie : Méthodes usuelles de « mesure » d’intervalles (de 
transcription) 

1.0 Introduction 
Si la transcription moderne dépend avant tout du support écrit (la notation 
occidentale sur portée), l’identification des hauteurs (et des intervalles) et leur 
transcription s’est faite depuis l’Antiquité 17, notamment à travers la notation 
alphabétique. Les problèmes qui se posaient alors aux musiciens et théoriciens 
de la musique (nos actuels « musicologues ») étaient comparables à ceux 
rencontrés aujourd’hui, et ne sont que les reflets (les échos ?) de la vieille 
polémique entre aristoxéniens et pythagoriciens sur la détermination des 
échelles utilisées dans la musique grecque ancienne. Aux pythagoriciens, 
adeptes de la quantification mathématique des intervalles, les aristoxéniens 
opposaient le jugement de l’oreille et considéraient que l’écoute était la seule 
manière adéquate de déterminer les degrés de l’échelle. La méthode des 
pythagoriciens consistait à considérer que tout intervalle qui sortait du cadre de 
la théorie était « faux », et devait par conséquent être ramené à l’intervalle 
correspondant, « juste » mathématiquement ; les aristoxéniens, par contre, 
considéraient que tant que l’intervalle était perçu comme « juste » par l’oreille, 
il avait droit de cité et devait être inclus dans la théorie ad hoc. Dans 
l’argumentation développée dans l’introduction à cet article, la méthode 
pythagoricienne correspond tout à fait, paradoxalement, au processus 
d’identification des intervalles par analogie avec des intervalles d’un système de 
référence, considéré, implicitement ou non, mais sûrement arbitrairement, 
comme « juste » : nous avons vu que cette méthode menait à des erreurs, même 
chez des analysants familiers avec des musiques non tempérées. L’« écoute » 
aristoxénienne, même si elle peut remporter, pour le principe, l’adhésion, 
soulève néanmoins les mêmes problèmes exposés dans l’introduction et qui 
 

 
17 Voir à ce sujet et pour les remarques suivantes, notamment, [Mathiesen, 1999 et 2001] et [Chailley, 1979] 
pour la musique grecque ancienne, ainsi que [Kindī, 1965] pour la musique arabe. West (2005) et Vitale 
(1982) mentionnent de leur côté une notation cunéiforme ugaritienne qui s’appuie sur la mention des interval-
les successifs. Par ailleurs, l’article « notation » du New Grove – Dictionary of Music and Musicians (2001) 
comporte également une liste abondante de références bibliographiques sur le sujet. 
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peuvent se résumer en la difficulté de quantifier les intervalles (de les mesurer), 
surtout quand une oreille exercée « sent » que ces intervalles sortent du cadre 
habituel (pour l’« oreille » en question). En considérant qu’un musicologue ou 
un musicien expérimenté peut être capable de déterminer à l’oreille (par 
l’écoute) si un intervalle sort du cadre du système intervallique qui lui sert de 
référence, reste à pouvoir quantifier cette différence et à vérifier si elle 
correspond à des intervalles d’autres systèmes intervalliques que le système 
référentiel, ou si cette variation est inclassable en l’état. Ceci correspond en fait 
au processus inverse de l’« identification » des intervalles (que l’on apprend 
couramment dans les conservatoires et les universités aux musiciens et aux 
musicologues), et qui est le processus de « discrimination » des intervalles. Pour 
ce faire, les analysants ont utilisé plusieurs méthodes, dont j’expose les plus 
usuelles et typiques ci-dessous 18, dans l’ordre croissant de complexité et de 
pertinence (ou d’indépendance de l’écoute subjective) : 

1. La comparaison avec un système intervallique de référence stable ; dans 
cette catégorie, nous pouvons considérer deux sous-catégories : 

a) La comparaison « de mémoire auditive », ou comparaison 
spontanée avec le système de référence selon la mémoire auditive 
dont est imprégné l’analysant. 

b) La comparaison avec un instrument accordé à tempérament 
« fixe » : 

1. à accordage et diapason relativement stables (par exemple 
le piano), 

2. à accordage relativement stable et diapason variable (par 
exemple une clarinette ou un saxophone), 

3. à accordage et diapason variables (par exemple une 
guitare). 

2. La comparaison avec des instruments continus du type violon ou ‘ūd, ou 
encore un monocorde. 

3. La comparaison avec un instrument à tempérament variable et identifiable, 
de type clavier électronique à diapason et hauteurs modifiables. 

4. La comparaison avec un accordeur électronique 

 

 
18 Le but de cet exposé n’est en effet, pas d’effectuer une revue historique des méthodes utilisées pour mesurer 
(discriminer/identifier) des intervalles (ou transcrire des mélodies), mais bien de rappeler, en un ensemble 
coordonné, les différentes méthodes utilisées de nos jours, et de relever leurs points forts et leurs points 
faibles en ce qui concerne la précision des mesures effectuées ainsi que la fiabilité des transcriptions en 
résultant. 
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5. La mesure d’intervalles par des logiciels spécialisés, avec une méthodologie 
appropriée. 

Ces cinq méthodes ont chacune des avantages et des inconvénients que nous 
allons exposer dans la suite de cette première partie d’article, en remarquant que 
les trois dernières sont récentes et datent de l’avènement de l’ère électronique. 

1.1 Comparaison avec un système de référence stable 
Ceci concerne, comme explicité ci-dessus, la comparaison « instinctive », « à 
l’oreille », ou encore la comparaison avec un instrument à tempérament 
« fixe ». Dans le premier cas, un des avantages de la méthode est, pour une 
oreille exercée, de pouvoir identifier un système intervallique indépendamment 
du diapason utilisé, ou même de pouvoir « accompagner » les évolutions 
éventuelles de ce diapason ; l’inconvénient majeur en est la dépendance 
complète (de la transcription résultante) de la subjectivité du musicologue, ce 
dernier pouvant être amené à identifier des intervalles là où aucune 
identification n’est possible, et à négliger des variations qui peuvent être de 
l’ordre de la structure même du mode (ou de l’échelle modale), ou encore, plus 
subtilement, à quantifier (et, surtout, à qualifier) de manière erronnée des 
variations décelées par rapport à la « norme ». 

Dans le cas des instruments à tempéraments (relativement) stables, les 
instruments à diapason fixe peuvent se révéler inadéquats en cas d’évolution de 
la fréquence du diapason (ou tout degré de référence supposé « stable ») avec le 
temps (par exemple dans le cas d’évolution avec le temps de la fréquence de la 
fondamentale dans la mélodie analysée). Les instruments à accordage 
modifiable (comme la guitare) permettent de suivre ces dernières évolutions, 
même si le processus de réaccordage peut s’avérer laborieux (selon 
l’instrument). 

Dans tous les cas de figure, les « mesures » effectuées ne peuvent être que 
qualitatives (degré « plus haut » ou « plus bas » que le degré de référence, 
intervalle « plus petit » ou « plus grand » que l’intervalle de référence) et 
dépendent fortement de la capacité de discrimination auditive de l’analysant 
qui, selon la personne, la hauteur absolue et le timbre, est très variable ; ces 
méthodes ne peuvent être appliquées que dans le cadre d’une musique dont le 
système intervallique est complètement déterminé à l’avance, comme par 
exemple la musique tempérée égale, et représentative d’un répertoire que le 
musicologue ou le musicien maîtrise lui-même parfaitement ; même dans ce 
dernier cas, cependant, les variations éventuelles (glissandi, raccourcissement 
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d’intervalles en mouvement mélodique, etc.) ne pourront être décrites, au 
mieux, que de manière approximative 19. 

1.2 Comparaison avec des instruments continus 
Ce genre d’analyse est souvent pratiqué par des musiciens ou musicologues de 
la zone du maqām, mais peut être effectué par des violonistes (ou en utilisant un 
violon) ou avec tout autre instrument continu : l’avantage de cette méthode est 
qu’elle permet une reproduction plus précise des hauteurs et des intervalles et, 
par là, leur identification éventuelle pour peu que ces hauteurs et intervalles 
correspondent à des positions (souvent de doigtés) familières au musicien (et 
identifiées dans son système de référence) ; dans le cas inverse, cependant, la 
tendance à l’identification « forcée » (en « ramenant » des hauteurs ou des 
intervalles à des valeurs ou des positions plus familières) peut mener à des 
erreurs d’appréciation rédhibitoires 20. 

La comparaison avec un monocorde, même dans le cas de mesures de la corde 
pour une hauteur « identifiée », souffre de la même subjectivité qu’avec 
d’autres instruments « continus » : elle s’avère inefficace si le pouvoir de 
discrimination de l’oreille (et son exercice) ne permet pas d’échapper au 
phénomène d’identification 21. 

En définitive, cette méthode, bien que permettant à un musicologue 
expérimenté de vérifier ponctuellement la conformité de certaines hauteurs ou 
intervalles avec son système de référence (qui peut être complexe, tempéré 
inégal, etc.) 22, et de reproduire éventuellement et qualitativement des variations 
de la courbe mélodique, n’est généralement pas applicable en dehors du 
système référentiel de l’analysant, et devient d’autant moins efficace dans le cas 
de musiques complexes mélodiquement, notamment pour le chant mélismatique 
et/ou traditionnel ; cette méthode fonctionne également par analogie auditive, et 
dépend fortement, tout comme la première, du pouvoir de discrimination 

 

 
19 Un des exemples les plus frappants d’erreur de ce type est l’assimilation de l’intervalle central du genre 
hijāz, par des musicologues et musiciens occidentaux, à une « seconde augmentée » de la musique occiden-
tale, alors que la valeur réelle de cet intervalle tourne autour des cinq quarts de ton dans la pratique tradition-
nelle du maqām arabo-turco-persan (cf. Beyhom, 2007). 
20 Signalons ici, pour l’exemple, l’existence d’autres « instruments continus » servant ou ayant servi à mesurer 
des hauteurs, à l’instar de la sirène de Cagnard de Latour, voir webographie.  
21 Et peut se révéler très rapidement fastidieuse dans le cas de mélodies un peu complexes. 
22 Sachant que, de toute manière, aucun système de référence (auditive) ne peut prétendre, quelle que soit sa 
complexité, à une reproduction quantitative exacte de ces hauteurs et intervalles. 
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intervallique de l’écoute musicale (de l’« oreille » du musicologue ou du 
musicien). 

1.3 Comparaison avec un instrument à tempérament variable et 
identifiable  
Cette méthode pourrait s’imaginer avec, par exemple, un instrument à frettes 
déplaçables vers des positions identifiées et/ou quantifiées à l’avance : un tel 
instrument ne permettrait cependant pas une mesure suffisamment fine de 
l’intervalle et dépendrait du quadrillage de la touche, qui sera vite limité par des 
contraintes physiques (épaisseur de la frette et possibilité matérielle de définir 
des emplacements identifiés en nombre, mais également le nombre de frettes 
utilisables) : à ce sujet, il convient de rappeler l’existence, historiquement, de 
guitares à frettage complexe qui permettaient, suite à des manipulations parfois 
laborieuses, de jouer dans différents « tons » harmoniques en gardant une 
justesse équivalente indépendamment des transpositions 23 ; il faut également 
rappeler l’existence d’instruments à clavier comportant plusieurs rangées de 
touches supplémentaires à celle du piano (ou de l’orgue ou du clavecin) 
traditionnel, et qui permettaient également de jouer dans des tons différents et 
de transposer sans préjudice pour la « justesse » harmonique 24. Ce genre 
d’instrument est cependant inaccessible de nos jours au commun des mortels, et 
généralement relégué dans les musées d’instruments de par le monde ; il n’est 
par ailleurs pas prouvé que ces instruments aient pu servir à des problématiques 
comparables à celles que nous développons dans cet article : nous parlerons par 
conséquent ici uniquement d’instruments modernes du type clavier 
électronique, avec possibilité (courante) de modification du diapason mais 
également (moins courant) des hauteurs assignées aux touches. Dans ces 
derniers instruments, la définition est de l’ordre du cent en ce qui concerne les 
hauteurs, ce qui dépasse la capacité de discrimination des meilleurs musiciens 
ou facteurs, selon ce qu’a pu constater l’auteur 25. 

 

 
23 Notamment par un système de frettes particulières à chaque corde de la guitare, avec possibilité d’enficher 
des frettes (« barrettes » individuelles pour chaque corde) sur la touche suivant un système correspondant à 
une division de l’octave en 53 intervalles « égaux » (système de commas de Holder) [cf. Evans, 1979, p. 38, 
n  17 - Guitare « enharmonique »]. 
24 Voir notamment à ce sujet [Meeùs, 1977, 1980, 1986a, 1986b, 1998] : les transpositions dans ce genre de 
cas sont néanmoins et généralement limitées. 
25 La limite communément admise pour le pouvoir de discrimination de l’oreille est de cinq cents pour un 
musicien exercé ; j’ai pu constater de moi-même, au cours de recherches effectuées en Bretagne en 2002 et 
2003, que les facteurs de binious et bombardes arrivaient à distinguer des différences de l’ordre de 2 à 3 
cents ; cette précision est comparable à celle de musiciens et accordeurs libanais [Beyhom, 2003], mais 
également, selon le chanteur et clarinettiste Erik Marchand [comm. personnelle en date du 07 août 2006], à 
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Ce genre de solution permet d’établir des mesures rapides et relativement 
fiables à condition que l’oreille soit bien entraînée à : 

• discerner les variations minimes de hauteur, 
• différencier les transitoires (attaque et extinction) du son fondamental 

(il faut insister sur la partie centrale du son, là ou on « sent » qu’il se 
stabilise). 

Cette méthode, souvent efficace et rapide, dépend néanmoins de la qualité de 
discrimination de l’oreille de l’auditeur, ce qui est un « manque » pour la mé-
thodologie, et est difficilement applicable dans le cas de chants mélismatiques 
(en général fortement non tempérés, avec des variations quasi continues des 
hauteurs), ou encore de fondamentales évolutives (nécessité de reprogrammer le 
clavier à chaque variation significative, et impossibilité pratique 26 de suivre des 
évolutions continues). 

Remarque : Il faut signaler, à ce stade de l’exposé, que les trois méthodes 
abordées jusqu’ici ont en commun un avantage appréciable par rapport aux 
deux suivantes, qui est qu’elles permettent, pour peu que les timbres des ins-
truments soient différenciables à l’écoute, d’effectuer des « mesures » pour des 
instruments (y compris la voix) au sein d’un ensemble. 

1.4 Comparaison avec un accordeur électronique 
J’ai pu observer l’utilisation de cette méthode à Téhéran, en 2005, en marge du 
congrès international Safiyuddīn Urmawī, à l’IFRI 27 : le musicien utilisait un 
qānūn 28 dont il accordait les cordes à l’unisson des hauteurs produites par un 
autre instrument (dans ce cas de figure, à cordes et fretté), et vérifiait tour à tour 
les hauteurs des deux instruments en les comparant aux lectures de l’accordeur 
(qui donnait les hauteurs en fréquences, dont on retraduisait ensuite les rapports 
en cents). Une autre possibilité est de mesurer, directement sur le « VU mètre » 
de l’accordeur, le différentiel avec une hauteur absolue quelconque 29.  

 

 
celle qu’il a pu constater pour lui-même en utilisant également un clavier à diapason transposable et hauteurs 
assignables (et quantifiables) en cents. 
26 Dans l’état actuel de la technologie disponible. 
27 Institut Français de Recherche en Iran. 
28 Cithare de la tradition arabo-turque, pourvue de 72 à 78 cordes triples (modèle égyptien notamment) 
couvrant à peu près 3 octaves (cf. Tranchefort, 1980, p. 243-245). 
29 Pour ce faire, il faut que le son perdure un tant soit peu (pour une stabilité de l’aiguille – ou de son équiva-
lent numérique) : certains musiciens (ou musicologues) utilisent pour ce faire des logiciels de traitement du 
son qui « allongent » la durée du son, sans (en principe) en modifier la hauteur ; cette procédure est un peu 
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Cette dernière méthode permet de vérifier ponctuellement des hauteurs, et de 
calculer des intervalles en effectuant les opérations mathématiques 
correspondantes ; elle a l’avantage d’être indépendante de la capacité de 
discrimination de l’oreille, mais est extrêmement limitée dans ses applications : 
elle ne permet en effet ni d’avoir une idée claire des changements éventuels 
d’intervalles, notamment par un phénomène de « tiré » des cordes sur la frette 
d’un instrument à cordes (de type sāz ou guitare), et encore moins de suivre les 
évolutions de la note notamment pour les transitoires d’attaque et d’extinction 
que nous aborderons plus en détail dans la deuxième partie de cet article. Il va 
sans dire que, pour l’analyse d’une mélodie quelconque, ce genre de mesure 
donne des résultats limités ; elle est néanmoins indépendante de la capacité de 
discrimination de l’oreille, ce qui constitue, à l’évidence, un plus en ce qui 
concerne la rigueur scientifique 30. Par ailleurs, et tout comme la méthode 
suivante, elle a le désavantage, souvent rédhibitoire, de ne permettre que la 
mesure de hauteurs de sons issus d’un instrument unique. 

1.5 Mesures d’intervalles avec des logiciels spécialisés 
Cette solution, la plus complète en musicométrie des intervalles, doit cependant 
s’accompagner de précautions évidentes et nécessite la maîtrise d’une chaîne de 
programmes complémentaires et indispensables à l’analyse. Nous verrons les 
détails de ces conditions, nécessaires pour une validation des résultats obtenus, 
en seconde partie d’article : nous nous contenterons dans cette section d’en 
relever les différents avantages et désavantages identifiés à ce jour. 

À part la nécessité de maîtriser un tant soit peu l’outil informatique 31, quelques 
autres préalables sont nécessaires pour l’application de cette méthode, notam-
ment : 

• Le logiciel doit avoir été testé et sa fiabilité prouvée et quantifiée, au-
tant que possible, selon les timbres, les hauteurs absolues ainsi que les 
paramètres d’analyse (bornes de fréquence, pas de mesure, compréhen-

 

 
lourde, et dépend de la qualité des algorithmes utilisés dans le programme [cf. le test des logiciels « Cool 
Edit » et « Audacity » en Annexe]. Le même problème existe par ailleurs pour les instruments « continus » 
(deuxième méthode revue dans cet exposé), dès que les variations de hauteurs et d’intervalles deviennent trop 
rapides (par exemple dans le cas de glissandi suivis de changements rapides et/ou subtils des hauteurs). 
30 Il faut noter néanmoins ici que cette « rigueur » scientifique dépend en fait des algorithmes utilisés par 
l’accordeur électronique, qui ne sont en général nullement explicités dans les brochures mises à la disposition 
de l’utilisateur : c’est l’exemple type de la « boîte noire » qui donne toujours des résultats, mais ne permet pas 
de vérifier leur pertinence. 
31 Ce qui était l’apanage de quelques uns devient rapidement une nécessité pour tous. 
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sion du principe de fonctionnement des algorithmes utilisés pour éviter 
notamment les résultats de type « boîte noire », etc.). 

• L’enregistrement sur lequel est effectuée l’analyse doit, autant que pos-
sible, correspondre à l’original et ne pas avoir été traité à l’aide de fil-
tres quelconques (« nettoyage » d’enregistrements anciens, élimination 
arbitraire des bruits de fond, etc.) ou encore avoir subi des transforma-
tions algorithmiques de transfert de données (par exemple passage du 
format « WAV » au format « MP3 » et vice versa). Cet enregistrement 
doit également être accessible au lecteur, soit par sa mise à disposition 
sur un support matériel (ou encore par internet) si l’auteur possède les 
droits de l’enregistrement et/ou les autorisations nécessaires, soit à tra-
vers l’indication précise et fiable de la référence de l’enregistrement si 
ce dernier est disponible dans le commerce. 

• Une méthodologie rigoureuse (et de « bon sens ») des mesures doit être 
appliquée, notamment en ce qui concerne les points ou segments de 
mesures, et la mise à disposition du lecteur de l’ensemble des données 
ayant permis de conclure dans un sens ou dans l’autre de l’analyse 
(idem bornes de fréquence et pas de mesure, mais également informa-
tions sur le traitement de « sauts » d’octave ou de « sauts harmoni-
ques » éventuels, identification si possible des transitoires sur graphique 
de relevés des hauteurs, comparaisons si nécessaire de mesures ponc-
tuelles sur le tronçon central avec une mesure moyennée, etc.) est une 
nécessité déontologique. 

• Laisser le bon sens (musical, l’« écoute ») guider l’analyse musicomé-
trique, et accepter en retour de se laisser guider ou remettre en question 
par les résultats obtenus, même s’ils peuvent, à première écoute, 
contredire le sentiment ou la perception auditive de l’analysant. 

• Vérifier et revérifier les résultats. 
• Se rappeler qu’une mesure comprend toujours un taux d’erreur 32, et en 

tenir compte pour l’analyse finale. 
Ces préalables, conjugués à une méthodologie cohérente, permettent d’obtenir 
des résultats très efficaces, y compris en ce qui concerne des musiques très 
complexes mélodiquement comme nous nous proposons de l’exposer en 2e 
partie de ce dossier ; il n’en reste pas moins que, malgré des possibilités 

 

 
32 Il est remarquable que le taux d’erreur constaté, en cas d’application correcte de la méthodologie préconi-
sée, est proche de celui de la définition de l’oreille soit de 2 à 5 cents pour des intervalles de l’ordre du ton. 
Pour plus de précisions, lire la partie des annexes consacrée au test du logiciel Praat. 
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d’isolement de certains sons d’instruments au sein d’un ensemble en vue de 
l’analyse, cette méthode ne peut s’appliquer couramment pour ce dernier cas, ce 
qui en limite la portée pratique, plus particulièrement dans le cas de musiques 
polyphoniques. 

1.6 Conclusion de la 1e partie 
Nous avons revu rapidement, dans cette première partie, différentes méthodes 
de mesures d’intervalles pour l’analyse et, notamment, la transcription de 
mélodies modales. Ces méthodes ont chacune des avantages et des inconvé-
nients, notamment pour la dernière qui, bien que la plus solide sur le plan de la 
validation scientifique (comme nous nous proposons de le démontrer en 2e 
partie d’article), ne permet néanmoins pas (encore, et sauf exceptions, cf. note 
n° 16) d’effectuer des mesures pour des instruments au sein d’ensembles : ce 
défaut n’existe pas pour d’autres méthodes abordées dans le cours de cette 1e 
partie, mais ces dernières sont défectueuses sur le plan méthodologique, sauf 
dans des cas triviaux qui restent néanmoins tributaires d’une validation indé-
pendante du sens de l’écoute humain. 

L’exposé en deuxième partie d’article aura pour but de préciser la méthodologie 
à appliquer pour la dernière de ces méthodes - qui font toutes partie de l’arsenal 
analytique mis à contribution par le musicologue pour une meilleure compré-
hension des musiques modales, et sont complémentaires entre elles. 

IIe partie : Tonagrammes 

2.0 Introduction à la deuxième partie 
Les méthodes modernes 33 de détermination de la hauteur d’un son se basent sur 
un choix entre différentes hauteurs possibles, auxquelles l’algorithme de calcul 
choisi assigne une probabilité (d’être le son fondamental) en fonction de la 
présence d’autres fréquences dans le spectre sonore du son analysé. Cette 
méthode, décrite ici de manière très succincte et simplifiée, se différencie de 

 

 
33 Cette partie se base partiellement sur un document intitulé « Praat tutorial for musicologists » (voir 
possibilité de téléchargement en liste bibliographique), notamment en ce qui concerne les commandes du 
logiciel Praat (Version 4.0.49) et certaines suggestions de chronologie de l’analyse. Ce document donne 
également des indications pratiques pour la manipulation du logiciel qui seront utiles au musicologue désireux 
d’effectuer des analyses de hauteurs (ou de rythmes), mais qui dépassent le cadre que nous nous sommes 
donné dans ce dossier. Pour les correspondances hauteurs/harmonique fondamental et pour des comparaisons 
entre différentes méthodes de détermination de la fondamentale, voir également Gerhard, 2003, téléchargé le 
09/02/2007. 
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méthodes plus anciennes consistant en l’application de filtres successifs élimi-
nant certaines fréquences au fur et à mesure jusqu’à arriver à isoler le son 
fondamental. Bien entendu, le résultat final dépend des paramètres choisis, 
notamment de la finesse de détermination des différentes composantes du son 
pour la première méthode, et celle du choix de l’étagement des filtres pour la 
deuxième. Nous ne nous étendrons pas ici sur ces paramètres, mais simplement 
sur la méthodologie générale à suivre pour que la subjectivité du musicologue 
ne vienne pas détruire l’objectivité (ou la « neutralité ») du programme. Les 
exemples ci-dessous sont issus d’analyses effectuées avec le logiciel Praat 
mentionné supra, qui permet notamment de reproduire des tonagrammes (rele-
vés fréquences/temps avec possibilité de quadrillage graphique en fractions du 
ton) 34 et de comparer, par exemple, plusieurs passages similaires d’un même 
chant entre eux, ou encore de vérifier et mesurer des processus fins d’évolution 
de la mélodie. Pour ce faire, nous allons essayer d’analyser plusieurs extraits de 
mélodies monodiques, instrumentales ou vocales, en essayant de dégager, par 
l’exemple, une méthodologie simple pour assurer une adéquation (et la fiabilité) 
des résultats des mesures. 

2.0.1 Considérations générales pour les mesures d’intervalles avec un logiciel 
dédié 

Premièrement, il est important d’insister sur la traçabilité des analyses et mesu-
res effectuées : à part la référence, évidente pour un musicologue, à l’auteur et à 
l’éditeur, au nom du morceau (ou, à défaut, à sa description) ainsi qu’à la date 
de publication et, surtout dans le cas d’enregistrement hors du domaine public, à 
la date et au lieu d’enregistrement, il faut également, en annexe ou dans le corps 
de l’analyse, préciser le positionnement des extraits analysés au sein d’un 
morceau, un minimum d’honnêteté intellectuelle imposant à l’analysant de 
mettre à la disposition du lecteur-auditeur l’intégralité des musiques analysées 
(ou d’indiquer pour le moins les références exactes et les bornes temporelles des 
extraits enregistrés pour les enregistrements disponibles dans le commerce), 
ainsi que les segments analysés (en cas de moyennes) ou emplacements précis 
des mesures (ponctuelles) effectuées. Dans le cas contraire, le musicologue aura 
beau jeu de prétendre que l’analyse fait ressortir des particularités du chant non 
discernables directement à l’écoute, la seule « garantie » fournie étant sa cau-
tion propre 35 ce qui, dans tous les cas de figure, ne peut être considéré comme 
 

 
34 Remarque : Praat utilise l’algorithme « accurate autocorrelation » (« auto-corrélation précise »), décrit dans 
(Boersma, 1993), et qui est une amélioration de la méthode par auto-corrélation « simple » décrite dans 
(Gerhard, 2003, p. 6-7). 
35 Ou, de manière plus subtile, quand les mesures sont effectuées en laboratoire par des spécialistes de 
l’acoustique, le musicologue ne faisant qu’interpréter des résultats à la gestation desquels il n’a pas contribué. 
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de l’objectivité scientifique. Par ailleurs, un principe simple doit être observé 
préalablement à toute mesure, qui est le passage du général au particulier, avec 
une observation préalable des bornes de fréquences du morceau : en effet, une 
mise en situation de l’extrait à analyser ainsi que des interférences possibles 
(par exemple de percussions ou de bruits de pas ou de voix quelconques) per-
met d’éviter d’emprunter des pistes d’analyse qui peuvent s’avérer inadéquates. 

2.1 Exemples « simples » 
La première analyse (simple) que nous effectuerons sera donc celle d’extraits 
d’un enregistrement de bombarde de fabrication bretonne, et jouée par le son-
neur (et facteur d’instruments) Jorj Botuha 36. Cet enregistrement a été choisi 
pour une première approche à cause de la (relative) stabilité des degrés de la 
bombarde jouée « à vide » (échelle « normale », jouée de la manière la plus 
« neutre » possible).  

Le logiciel utilisé n’étant pas une « boîte noire », un certain nombre 
d’opérations préliminaires ont été effectuées pour déterminer l’ambitus de 
fréquences pour le son fondamental (premier partiel) ; une première estimation, 
large, est proposée, avec des bornes en fréquences de valeurs 75 (« basse ») et 
2400 Hz (« haute ») 37, avec une subdivision de l’extrait analysé en 500 pas de 
temps 38.  

Le graphique (figure 1) mixte 39 sonagramme (en haut) et fréquence/temps 
(ligne brisée du bas) 40 permet de déterminer que la borne inférieure des fré-

 

 
36 Tous les enregistrements avec ce musicien ont été effectués le 13 décembre 2003, dans son atelier à 
Aurray - Bretagne. 
37 L’approche « large », que ce soit pour un chant ou une pièce musicale dans leur entièreté, ou encore 
concernant les fréquences couvertes par l’analyse logicielle, est indispensable - comme préalable à l’analyse - 
pour diverses raisons, dont la nécessité de mieux situer l’extrait analysé au sein du morceau, et de vérifier la 
manière dont réagit l’algorithme de détermination de la fréquence fondamentale en comparant les résultats 
avec l’écoute de l’analysant. Cet exercice est loin d’être gratuit, et ses résultats peuvent suggérer des pistes 
nouvelles d’analyse au musicologue tout en permettant de mieux situer les particularités d’un extrait quel-
conque par rapport au reste de la musique analysée, et de corriger éventuellement, dans une deuxième 
hypothèse, des sauts d’octave ou de quinte dans la détermination de la fondamentale (cf. Van Der Meer – 
webographie). 
38 Commandes Praat pour le nombre de pas de mesure : dans la fenêtre d’édition créée (voir infra), menu puis 
commandes « Pit.(ch) > Pitch settings > 500 (première valeur à renseigner) ». Notons ici qu’une analyse avec 
un pas de temps de 1/100e de seconde environ est suffisante, en général, pour des relevés de hauteurs et des 
calculs d’intervalles ; le pas de temps dans cette première analyse « grossière » est approximativement égal à 
1/20e de seconde. 
39 Commandes « Sound left > Edit » dans Praat ; toutes les analyses sont effectuées, dans ce logiciel, sur un 
son mono : il suffit donc de lire un fichier « WAV » ou « aif » stéréo et de choisir une des pistes gauche ou 
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quences à analyser se situe aux alentours de 437 Hz (sur le côté droit – bas – du 
graphique) 41. 

Une opération similaire (positionnement de la souris dans le plan, à la hauteur 
du segment approximativement le plus haut dans le relevé fréquence/temps) 
pour déterminer la borne supérieure permet de la situer à approximativement 
825 Hz.  

 
Figure n° 1. Graphique mixte sonagramme et relevé fréquences/temps, bom-
barde « copie Karnak » jouée par Jorj Botuha – piste CD n° 09 42.  

 

 
droite – dans cet exemple, la piste de gauche a été choisie, et les commandes préalables de lecture utilisées 
sont « Read > Two sounds from stereo file ». 
40 Le spectrogramme a été éliminé de cette représentation, pour une plus grande clarté de l’exposé ; comman-
des dans la fenêtre d’édition « View > Show analyses > (cocher uniquement la case “show pitch”, et « déco-
cher » les autres) ». 
41 Les bornes et mesure de l’analyse en fréquence figurent sur le côté droit de la partie basse du graphique ; les 
bornes de l’analyse du spectre (et de la fréquence correspondant au point de mesure) figurent sur le côté 
gauche. 
42 Réf. : 20GammesAscDesc_JB_(20)_CopieEnLa(Karnak)_JB_13_12_2003_(24 1es secondes).wav ; sur une 
bombarde en la fabriquée par Jorj Botuha (Vannes), copie d’un original (en la) de la région de Karnak, dotée 
pour l’occasion d’une anche large en buis. 
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À partir de ces bornes, élargies par sécurité (à approximativement plus ou 
moins 5 %, soit à 850 Hz pour la borne supérieure, et 400 Hz pour la borne 
inférieure – pour simplification de la lecture des graphiques), nous pouvons 
mener une analyse plus approfondie de l’évolution des fréquences fondamenta-
les avec le temps. 

Une première analyse 43, effectuée sur la troisième série de hauteurs (« échelle » 
comprise entre la 8e et la 16e secondes – figure 2) 44, permet d’obtenir un tracé 
(figure 3) simple du relevé fréquence/temps, et de vérifier la cohérence des 
opérations effectuées jusqu’à ce point de l’analyse. 

 

 
Figure n° 2. Sélection de la troisième « échelle » au sein de la fenê-
tre « Edit Pitch » du relevé fréquences/temps, bombarde « copie 
Karnak » jouée par Jorj Botuha – piste CD n° 10. 

 

 
43 Commandes « Sound left > Periodicity > To pitch », avec un pas de 1/100e de seconde, et mise des bornes 
de fréquence à 400 et 850 Hz ; ceci est cependant et peut-être une restriction trop drastique pour les analyses 
plus complexes, surtout pour repérer les phénomène de « quintoiement » ou d’octaviation des instruments à 
vent : une règle simple, pour ce genre d’analyse, est de diviser la valeur de la borne inférieure par deux et 
d’arrondir à la dizaine inférieure, et de multiplier celle de la valeur supérieure par 2 également et d’arrondir à 
la centaine (cinquantaine) supérieure. 
44 Commande « Pitch left > Edit » ; la procédure de sélection s’effectue par une opération simple de click 
gauche de souris à partir de la gauche de la zone (8 secondes), et d’étirement vers la droite de la zone 
sélectionnée jusqu’à la valeur de temps désirée (16 secondes) puis par la commande « View > Zoom to 
selection » ou, pour plus de précision dans la sélection, par la commande « View > Zoom … > (bornes 
exactes à renseigner) ». 
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Figure n° 3a. Fenêtre d’édition de l’extrait du relevé fréquen-
ces/temps, bombarde « copie Karnak » jouée par Jorj Botuha – 
piste CD n° 10 45. 

 

À ce stade 46, l’analysant a le choix entre une analyse détaillée, segment par 
segment, du tracé fréquence/temps, ou à une analyse globale par comparaison 
avec une grille intervallique quelconque. Vu la régularité du relevé (« échelle ») 
et la relative stabilité des degrés, l’analyse choisie ici sera une analyse globale, 
pour essayer de déterminer rapidement les subdivisions de l’échelle. Pour ce 
faire, nous devons passer par une « transposition » (une transformation homo-
thétique) des fréquences relevées sur une « fondamentale » de 100 Hz 47, d’où la 
nécessité de déterminer, au préalable, la « fondamentale » (en fait tout simple-
ment le degré le plus bas mesuré) de notre bombarde. Le choix ici doit se porter 
sur le segment le plus stable (ligne horizontale), soit la dernière portion (située 
approximativement entre 14,8 et 16 secondes), et en sélectionnant cette zone 
 

 
45 Commande « Pitch left > Edit » avec mise des bornes de fréquence à 400 et 850 Hz, et de temps à 8 et 16 
secondes. 
46 On ne saurait trop insister, ici, sur la nécessité d’une réécoute de l’extrait, à partir du résultat de l’algorithme 
de détermination de la fréquence fondamentale, et de le comparer à l’original : Praat permet cette écoute en 
« hum » (la traduction la plus proche correspondrait à « bourdonnement ») ou en « pulse » (« impulsion »), en 
sélectionnant (dans la fenêtre Praat objects) le résultat du calcul (« pitch left » ou « pitch right » au choix 
pour un extrait non différencié spatialement) et en cliquant sur « play » ; pour réécouter l’original et effectuer 
une comparaison, il suffit de re-sélectionner l’objet « sound left » ou « sound right », et de cliquer également 
sur « play ». 
47 Cette restriction est imposée par le logiciel, et ne fait pas partie de la méthodologie en tant que telle. 
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puis en l’agrandissant 48 (figure 3b), nous pouvons nous rendre compte que la 
« fondamentale » choisie est remarquablement stable ; dans ce genre de cas de 
figure, il suffit d’éviter les transitoires d’attaque et d’extinction, de repérer le 
segment central ou la portion la plus stable en son sein, et de délimiter le seg-
ment de mesure au sein de cette portion (partie sélectionnée en figure 3b) 49, et 
de mesurer la moyenne 50 des mesures au sein de ce segment (pour plus de 
fiabilité). Le calcul de la moyenne (437,82 Hz) confirme notre première estima-
tion « grossière » de la fréquence de la fondamentale (437 Hz).  

 

 
Figure n° 3b. Représentation de la portion comportant le son « fondamen-
tal » choisi – pistes CD 11 (sélection) 51.  

 

À partir de là, et la transformation homothétique effectuée 52 (figure 4), nous 
pouvons redessiner ce relevé sur fond d’une grille en demi-tons (figure 5) : une 

 

 
48 Command « View > Zoom … > (fixation des bornes entre 7,18 secondes et 7,72 secondes) ». 
49 En ayant soin de vérifier que la forme de la courbe (vérifiée pratiquement par une tangente « vectorisée ») 
est approximativement la même au début et à la fin du « segment » choisi – voir figures n  13, 17 et 18. 
50 Commande « Query > Get pitch », la section à « moyenner » devant être sélectionnée au préalable. 
51 Commandes « View > Zoom to selection » dans la fenêtre créée avec la commande « Pitch left > Edit ». 
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simple observation visuelle permet de nous rendre compte que les 2e, 3e, 4e et 6e 
degrés de l’échelle ne correspondent ici que très imparfaitement à la grille en 
demi-tons.  

Une représentation sur grille en quarts de ton (figure 5b) permet de se rendre 
compte que les 4 premiers degrés de l’échelle représentent approximativement 
l’aspect zalzalien 53 bayāt, composé de deux secondes « neutres » (à peu près 
trois quarts de ton soit délimitées, sur le graphique, à 1,5 et 3 demi-tons) suivies 
d’un intervalle valant un ton, avec une quarte légèrement augmentée, une quinte 
relativement juste, une sixte située approximativement à 5/4 de tons au dessus 
de la quinte, avec un septième degré placé à un demi-ton au dessous de l’octave.  

Il est peut-être utile de signaler ici que la gamme mesurée sur place avec un 
clavier-arrangeur EM 50 – OR, avec une écoute commune avec le musicien 
après enregistrement, avait été approchée à une fondamentale de 438.7 Hz, et 
des intervalles ascendants valant successivement 165, 175, 190, 180, 224, 182, 
et 88 cents, soit un total de 1204 cents à l’octave. Ces résultats ne sont pas trop 
éloignés de ceux de la figure 5, ce qui confirmerait que des oreilles exercées 
peuvent, avec l’aide d’un instrument à diapason et tempérament variables, 
approximer assez précisément des intervalles stables comme ceux de cette 
échelle. 

 

 

 
52 Cette transformation se fait par division de la fréquence de la nouvelle fondamentale (100 Hz) par les 
fréquences relevées, opération qui correspond à repositionner toutes les hauteurs à partir d’une fondamentale 
à 100 Hz. Commande (fenêtre Praat objects) « Sound Left > Modify > Formula (dans ce cas précis : “self” * 
100/437.82) » 
53 Les intervalles zalzaliens, de Mansūr Zalzal, (Abou Mrad, 2005, p. 772) ūdiste de la seconde moitié du 
VIIIe siècle, qui aurait été le premier à « placer » une « ligature » [plusieurs écrits anciens font supposer que 
ces « ligatures » étaient de simples marques sur la touche du ūd (Erlanger 1938, p. 111 : « Les ligatures sont 
des marques faites sur le manche des instruments à cordes »)] matérialisant des intervalles sortant du cadre 
diatonique et correspondant aux « secondes neutres », de valeur approximativement égale à trois quarts de 
ton, contenues dans le tétracorde de base de la musique arabe ; ce dernier est décliné sous les trois formes T – 
J1 – J2 (ton, 1e « seconde neutre » mujannab, 2e « seconde neutre », avec J1 légèrement différent de J2), J1 – T– 
J2, et J1 – J2 – T ; l’indice bas pour les « secondes neutres » ne les identifie pas (comme ayant une valeur fixe), 
mais sert à les différencier comme ayant des valeurs inégales (pour éviter une référence à la valeur uniforme 
de ¾ de ton qui leur est attribuée dans les théories contemporaines du maqām), variables selon les modes et 
les musiciens. Par extension, l’adjectif zalzalien s’applique à tous les intervalles sortant du cadre diatonique 
strict, notamment la seconde « légèrement augmentée » (de valeur approximative 5/4 de ton) du tétracorde 
hijāz, ou à tout intervalle correspondant approximativement à un multiple impair du quart de ton (tierces, 
quartes, quintes etc. « neutres » ou « légèrement augmentées » [ou « diminuées »]) que l’on retrouve dans la 
littérature spécialisée. 
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Figure n° 4. Fenêtre d’édition de l’extrait du relevé fréquen-
ces/temps après transformation homothétique avec fondamentale 
à 100 Hz 54. 

 
Figure n° 5a. Graphique de l’extrait du relevé fréquences/temps sur 
grille en demi-tons 55. 

 

 
54 Le plafond (« ceiling ») a été, pour la clarté de l’exposé, mis à 200 Hz pour cette figure : commande « Edit 
> Change ceiling (200) ». 
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Figure n° 5b. Graphique de l’extrait du relevé fréquences/temps sur grille en 
quarts de ton (unités en demi-tons) 56. 

 

Bien évidemment, cet exemple est simple, les notes étant bien détachées et le 
vibrato relativement réduit. Une deuxième analyse est proposée, sur un extrait 
du même musicien, sur la même bombarde, cette fois-ci « en jeu normal », sur 
un extrait de Paotred er gueù à bleuigner 57. L’aspect global de la courbe fré-
quence/temps est reproduit en figure 6. 

 

 
55 Commandes « Draw > Semitones > (bornes de temps fixées à 8 et 16 secondes, bornes de “fréquence” entre 
-1 et 12 demi-tons) » puis, au sein de la fenêtre Praat picture  « Margins > Marks left every (Units = 1, 
Distance = 1) » : les bornes de « fréquence » ont été choisies de manière à obtenir un remplissage optimal du 
plan du graphique, soit un demi-ton en dessous et en dessus des fréquences extrêmes observées ; le quadril-
lage horizontal s’obtient par la deuxième série de commandes, en assignant à l’unité la valeur d’un demi-ton 
et en faisant dessiner les lignes-tirets horizontales pour toutes les unités. 
56 Au sein de la fenêtre Praat picture, obtenue de la même manière que pour la grille en demi-ton, « Margins 
> Marks left every (Units = 1, Distance = 0.5) », soit en assignant à l’unité la valeur d’un demi-ton et en 
faisant dessiner deux lignes-tirets horizontales par unité (ou toutes les moitiés d’unités, soit tous les quarts de 
ton). 
57 Réf. : 19Paotred_er_gueù_à_bleuigner_JB_(19)_CopieEnLa(Karnak)_JB_13_12_2003.wav 
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Figure n° 6. Relevé fréquences/temps, bombarde « copie Karnak » jouée « en 
situation » par Jorj Botuha – piste CD n° 12 58. 

Pour ce morceau, nous nous concentrerons sur la quatrième phrase musicale, 
avec une tranche temporelle comprise entre 17,5 et 25 secondes de l’extrait 
original (fig. n° 7). 

 
Figure n° 7. Relevé fréquences/temps, bombarde « copie Karnak » jouée « en 
situation » par Jorj Botuha – extrait, piste CD n° 13 59. 

Ce relevé, après un traitement similaire à celui décrit pour la figure n° 4 (trans-
formation homothétique), situe les degrés, sur grille de demi-tons, comme 
reproduit dans la figure n° 8 60.  

 

 
58 Commande « Stereo left > Edit ». 
59 De 17.5 à 25 secondes. 
60 Analyse sur l’extrait non transformé entre 400 et 800 Hz (pour éliminer les phénomènes de quintoiement et 
d’octaviation), avec un pas de temps de 1/1000e de seconde (pour la précision de l’analyse). 
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Figure n° 8. Graphique de l’extrait du relevé fréquences/temps sur grille en 
demi-tons 61. 

 

Nous pouvons facilement observer, sur ce graphique, que si les quartes (« 5 » 
demi-tons) et les quintes (« 7 » demi-tons) sont relativement « justes » (en fait 
légèrement « larges »), et que la sixte est « diatonique » (« 9 » demi-tons), la 
seconde, par contre, sort nettement de ce cadre et correspond clairement à une 
seconde « neutre » de type zalzalien (figure n° 9) 62 ; l’aspect bayāt 63 du tétra-
corde zalzalien paraît également être confirmé ici. 

À partir de ces premiers résultats, nous nous rendons compte que, pour une 
analyse globale de l’échelle utilisée, cette méthodologie est suffisante dans le 
cas de jeu d’instruments à notes relativement stables et détachées. 

 

 
61 Rappel : commandes « Draw > Semitones > (bornes de temps fixées à 17.5 et 25 secondes, bornes de 
“fréquence” entre -1 et 12 demi-tons) » puis, au sein de la fenêtre Praat picture  « Margins > Marks left every 
(Units = 1, Distance = 1.) ». 
62 Il faut noter que cet arrêt sur le deuxième degré zalzalien (ou du moins « légèrement diminué ») parait être 
fréquent en musique bretonne, et fera l’objet d’une analyse approfondie pour le dossier complémentaire 
prévu, concernant notamment la validation statistique d’un répertoire. 
63 Soit J – J – T, soit deux tierces « neutres » (approximatives) suivies par un intervalle valant un ton. 
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Figure n° 9. Graphique de l’extrait du relevé fréquences/temps sur grille en 
quarts de ton 64. 

 

2.2 Analyses « générales » 
Dans le cas d’analyses plus générales encore, par exemple le suivi de la courbe 
d’évolution de la fondamentale en cas (le plus fréquent) de séquences vocales 
répétitives, la première étape peut suffire, avec une résolution temporelle suffi-
sante, comme par exemple sur l’exemple suivant d’un chant breton par Jean-
Marie Long et Pierre Fer 65. Dans ce chant, la mesure exacte des hauteurs est 
rendue difficile de par le recoupement des voix des deux chanteurs à certains 
passages (tuilage Kan ha diskan), mais également par le bruit de pas accompa-
gnant le chant, décelables dans les brusques descentes vers les fréquences 
basses (figures 10a et 10b).  

L’état de l’enregistrement (ancien) avec une forte présence de fréquences 
« résiduelles » (enregistrement sur bande) ne permet pas, pour nous, une ana-
lyse très détaillée des intervalles, l’analyse globale étant la seule recommandée 

 

 
64 Même procédure qu’en demi-tons, avec « Margins > Marks left every (Units = 1, Distance = 0.5) ». 
65 Enregistrement gracieusement fourni par Erik Marchand, de sa collection personnelle, août 2006. 
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dans ce genre de cas 66 ; certaines analyses de détail seront néanmoins abordées 
ici, à titre d’exemple. 

Ce chant est composé de douze couplets de forme AABB (figure 11), le premier 
et les deux derniers couplets étant des « tralalas ». Les deux phrases de forme A 
se terminent sur le 2e degré de l’échelle utilisée, les deux derniers (de forme B) 
sur le premier degré. Nous pouvons par ailleurs facilement remarquer sur la 
figure précédente une élévation régulière des fréquences avec le temps. 
L’évolution de la fondamentale avec le temps (ligne rajoutée sur la figure 10) 
s’effectue de manière quasi-linéaire.  

Une mesure ponctuelle, puis « moyennée » (sur le segment central, en évitant 
les transitoires d’attaque et d’extinction) de la première « tonique » (premier 
degré de l’échelle approximativement relevée, soit le degré le plus bas de la 
première phrase B) permet de la situer approximativement, en fréquences 
(figure 12), à 215 Hz.  

La même procédure, appliquée à l’avant-dernière phrase B (figure n° 13 – 
uniquement la « moyenne ») permet de nous rendre compte que la fréquence de 
la fondamentale s’est élevée jusqu’à approximativement 248 Hz, soit une diffé-
rence de 33 Hz environ et d’à peu près 250 cents 67 (à cinq cents près). 

 

 

 
66 Et en l’état actuel de la technologie disponible. 
67 Soit l’équivalent de cinq quarts de ton. 
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Figure n° 10a (haut) / 10b (bas). Fenêtre et graphique du relevé fréquen-
ces/temps d’un chant par Jean-Marie Long et Pierre Fer 68 – piste CD n° 14. 

 

 
68 Commandes « Stereo left > Edit » pour la figure 10a. 
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Figure n° 13. Mesure moyennée 71 de l’avant-dernière « tonique » d’un chant par 
Jean-Marie Long et Pierre Fer – piste CD n° 17 72. 

 

La mélodie qui, au début de l’enregistrement disponible, démarre sur un lab, 
suit très approximativement les degrés du l’aspect diatonique « majeur », encore 
qu’un relevé détaillé de la première phrase B (figure 14) suggère un « rétrécis-
sement » possible du pentacorde de base, et montre une variabilité certaine des 
degrés, y compris de la quinte, avec une première seconde, en valeur absolue, 
quasi zalzalienne 73. 

 

 
71 Commande (après sélection de la zone dont on veut obtenir la fréquence moyennée) « Query > Get pitch ». 
72 Extrait audio de la fenêtre complète. 
73 La première seconde zalzalienne ne peut être certifiée ici à cause du rétrécissement constaté des intervalles, 
notamment de la quarte et de la quinte résultantes. 
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Figure n° 14. Relevé graphique du premier passage A, sur grille en 
quarts de ton (exprimée en multiples du demi-ton) d’un chant par 
Jean-Marie Long et Pierre Fer. 

Ce rétrécissement, notamment de l’intervalle entre la « quarte » et la « quinte », 
est confirmé par le graphique des relevés fréquences/temps de l’avant dernière 
phrase A (figure 15) ; pour les deux graphiques, la « tonique » choisie est celle 
du passage B suivant. 

 
Figure n° 15. Relevé graphique de l’avant-dernier passage A, sur grille 
en quarts de ton (exprimée en multiples du demi-ton) d’un chant par 
Jean-Marie Long et Pierre Fer. 
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2.3 Exemple d’analyse « fine » 
Dans l’exemple d’une autre bombarde  jouée par Jorj Botuha 74, le relevé gra-
phique de l’échelle « à vide », ramené à une fondamentale de 100 Hz et sur 
grille en quarts de ton, est représenté en figure 16a, et celui d’un morceau 
exécuté sur la même bombarde en figure 16b (sans traitement homothétique).  

 

 
Figure n° 16a. Relevé graphique de l’échelle d’une bombarde du 
Morbihan (original en la) 75 – piste CD n° 18. 

 

L’échelle « à vide » fait ressortir, surtout en descente, un aspect zalzalien Rāst 
(se rapprochant d’un aspect diatonique de ré) sur la fondamentale (en T – J – J), 
avec une quarte juste et une quinte légèrement augmentée 76.  

La mesure de la tonique s’effectue sur le segment final (figure 17), en sélec-
tionnant la partie avec vibrato de manière, par exemple, à inclure trois périodes 
complètes, relativement stables, avec une moyenne d’à peu près 449 Hz 77. 

 

 
74 Réf. : 22GammesAscDesc_JB_(22)_OriginalEnLa(1850)_JB_13_12_2003 (extrait dernière).wav. Bom-
barde datant de 1850 environ, selon le musicien, et provenant d’Aradon (Golfe du Morbihan - France). 
75 La fondamentale a été, au préalable, mesurée et moyennée à 448,90 Hz. 
76 L’« étroitesse » du premier intervalle T fait pencher la balance du côté zalzalien plutôt que du côté « diato-
nique ». 
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Figure n° 16b. Relevé graphique de l’extrait final de Greis mad 
pier gali galan 78 – piste CD n° 19. 

 

 
Figure n° 17. Mesure moyennée de la « tonique » de Greis mad pier gali galan  – 
piste CD n° 20 79. 

Cette méthode est assez sûre, puisque la réduction à une seule période (figure 
18) donne quasiment le même résultat (à 448.84 Hz). 

 

 
77 Estimée à 445,4 Hz sur place, en comparant (à l’oreille) avec le son d’un clavier-arrangeur EM 50 – OR 
(Roland). 
78 Réf. : 21GreisMadPierGaliGalan_JB_(21)_OriginalEnLa(1850)_JB_13_12_2003 2e partie.wav  (integral). 
79 Pour l’extrait compris entre 15,455 et 17,291 secondes. 
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Figure n° 18. Mesure moyennée sur une seule période de vibrato de la « toni-
que » de Greis mad pier gali galan. 

 

La différence entre les deux fréquences, calculée avec des fréquences précises 
au centième près, est inférieure à 0,2 cents. 

Une moyenne sur un segment nettement plus large (figure 19), mais n’incluant 
pas les transitoires d’attaque et d’extinction (cette dernière étant ici impercepti-
ble), permet de nous assurer que notre première mesure est acceptable dans les 
bornes d’erreur admises comme postulat (± 2,5 cents 80), puisque le différentiel 
avec la première mesure à 448,836 Hz est inférieur à 0,6 cents (un cent en 
arrondissant).  

 

 
Figure n° 19. Mesure moyennée élargie de la « tonique » de Greis mad pier gali 
galan. 

 

 
80 « Sensibilité » de l’oreille humaine. 
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Par ailleurs, les fréquences individuelles, sur cette dernière portion moyennée, 
la plus basse et la plus haute relevées 81 valent 446,000 et 452,000 Hz 82 ce qui 
équivaut à un différentiel de 23,46 cents qui correspond grosso modo à 
l’amplitude du vibrato : cette dernière valeur est nettement trop élevée pour 
garder les mesures dans des bornes d’erreurs acceptables, d’où la nécessité d’un 
moyennage « intelligent », même pour des relevés relativement stables comme 
dans cet exemple 83. 

Enfin, et ayant choisi pour cette analyse la valeur de 448,89 Hz comme fré-
quence de la « fondamentale », nous obtenons le graphique suivant (figure 20), 
qui confirme l’aspect rāst du tétracorde fondamental, avec une quarte juste, 
ainsi qu’une quinte haute suivie d’une seconde zalzalienne, particulièrement 
discernable en descente. Remarquons également l’« attaque » caractéristique de 
la tonique (située à « 0 » demi-ton), à un quart de ton en dessous de ce degré 
(« -0.5 »). 

 

 
81 Dans un ficher spécial créé par le programme par la commande « Pitch > Write > Write to text file », sur les 
« frames » 1590 à 1696, correspondant, pour un pas de 1/100e de seconde, à la section de temps mesurée 
(entre 15,90 et 16,96 secondes). 
82 Les trois chiffres après la virgule dans les fréquences précédentes ne sont pas la marque d’un goût excessif 
chez l’auteur pour la précision numérique, mais correspondent simplement à une reproduction fidèle des 
résultats figurant dans le fichier résultant de la commande « Write to text file ». 
83 Remarquons ici un phénomène bien connu des acousticiens ou des familiers du calcul logarithmique, qui est 
que la valeur absolue (et quantitative) d’un différentiel de fréquence n’est pas significative en tant que telle : 
c’est le rapport entre fréquences qui délimitent l’intervalle qui fournit la grandeur de l’intervalle suivant la 

formule 
)2ln(
)ln( i

b
Rbi = , dans laquelle ib est l’intervalle à calculer, b est la base (nombre de subdivisions 

égales dans l’octave – pour un calcul en cents  b = 1200) et Ri le rapport de fréquences des hauteurs bornant 
l’intervalle à calculer. Dans le cas de sons à très basse fréquence à 20 Hz, par exemple, le différentiel observé 
supra (résultant en 0,6 c.) à 0,054 Hz résulterait en un différentiel en cents équivalant à (approximativement) 
5 cents (il est vrai inaudible pour des oreilles « normales », à cette fréquence) ; dans le cas de fréquences 
hautes, le différentiel observé supra (résultant en 23,46 cents) serait réduit, pour une fréquence en limite 
« basse » à 2000 Hz par exemple, à 5 (approximativement) cents également. 

09 - MESURES D’INTERVALLES pagin34   34 5/20/2007   12:04:09 PM



RTMMAM                                                                                                                      215 

 

 

 
Figure n° 20. Graphique sur grille en quarts de ton (unités en demi-tons) de 
Greis mad pier gali galan. 

 

2.4 Autres analyses « fines » 
Une première analyse est proposée ici, sur un extrait de genre hijāz performé 
par Kudsi Erguner 84. 

Dans une interview en mars 2005 85, ce musicien et musicologue me faisait la 
démonstration du genre h ijāz, avec, de préférence et selon l’enseignement des 
maîtres, une seconde « légèrement augmentée » (à 242 c., figure 1 – gauche), 
ainsi qu’une seconde augmentée exagérée (à 323 c., figure 1 – centre), à éviter 
dans la pratique musicale. 

 

 
84 Certaines caractéristiques de cette analyse ont été exposées dans l’article (Beyhom, 2007). 
85 Erguner, 2005, interview. 
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Figure n° 21. Nuances du genre h ijāz – Kudsi Erguner 86 – piste CD n° 21. 

 

Tableau n° 1 : nuances du genre h ijāz – Kudsi Erguner 87 

 

 

 

 
86 Mesures effectuées sur un extrait de l’enregistrement d’origine, entre 2:55 et 3:01 minutes. 
87 midb, sidb, fadd, ladd, etc.  mi demi-bémol, si …, fa demi-dièse, … etc., soit un degré abaissé ou haussé d’un 
quart de ton environ. 
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Cette analyse a été effectuée selon la méthodologie exprimée supra, avec calcul 
des intervalles sur des portions moyennées pour chaque degré. Dans le relevé 
fréquence/temps de la version complète de ce tétracorde (seconde « augmen-
tée » à 232 c., segments S7 à S13 sur la figure 21 - droite), nous remarquons 
une fluctuation des degrés (en l’occurrence le degré midb – en notation relative 
n° III dans le tableau n° 1, et le fa#) et celle, relative, de la seconde « augmen-
tée » (237 c. et 232 c., contre 242 c. dans l’exemple de gauche) ; en descente, 
les deux degrés se rapprochent de la tonique, mais l’intervalle central reste 
pratiquement inchangé 88. 

Sur un deuxième exemple de genre hijāz, performé sur ‘ūd par Hamdī Mak-
hlūf 89 (figure 22), la tonique, très stable (car sur corde à vide du ‘ūd), peut être 
mesurée (moyennée) à 149,12 Hz. 

 

Figure n° 22. Genre h ijāz, fenêtre « Stereo left > Edit » dans Praat – H amdī 
Makhlūf 90 – piste CD n° 22. 

 

 
88 Cette fluctuation semble être d’ailleurs une constante de la musique arabe, comme nous le verrons pour 
l’exemple suivant. 
89 Ūdiste tunisien, étudiant en musicologie à Paris IV - Sorbonne, et premier prix du conservatoire national de 
Sfax (Tunisie). 
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Figure n° 23a. Genre h ijāz, graphique fréquences/temps - Hamdī Makhlūf 91. 

Nous remarquons sur ce graphique une différence certaine entre intervalles et 
hauteurs en mouvements ascendant et descendant ; une première analyse sur 
grille de quarts de ton (figure 23b) confirme cette disparité. 

La variabilité des intervalles utilisés en musique(s) arabe(s) est ici confirmée, 
avec un hijāz ascendant quantifiable en 1/4 ( ?) - 6/4 – 3/4 de ton, et descendant 
en 2/4, 5(6)/4, 3(2)/4 de ton 92. Cette approximation est peu satisfaisante, no-
tamment à cause du « ¼ » de ton ascendant, incompatible avec les théories 
disponibles du maqām ainsi qu’avec la perception graphique du degré (relati-
vement) stabilisé. Une deuxième analyse, en 17es d’octave (figure 24), nous 
permet de mieux approximer ces intervalles. 

Sur ce graphique, nous distinguons plus clairement les intervalles, notamment 
en « montée », qui correspondent à 1 – 4  et 2 multiples de 17es d’octave, et à 2 
– 4 et 1 multiples de 17es d’octave (par ordre ascendant) en descente. 
 

 
90 Enregistrement en date du 16 mars 2005 ; l’analyse a été effectuée avec un pas de temps de 1/100e de 
seconde, entre 140 et 225 Hz. 
91 Réduit à une fenêtre de temps comprise entre 0 et 2,75 secondes pour la clarté de l’exposé. 
92 Rappelons ici qu’une des formes théorique du tétracorde hijāz correspond à (en montée) 3/4, 5/4 et 2/4 de 
ton (Beyhom, 2007, loc. cit.) 

as
ce

nd
an

t descendant 
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Figure n° 23b. Genre h ijāz, graphique fréquences/temps sur grille de quarts de 
ton (exprimée en multiples de demi-ton) - Hamdī Makhlūf 93.  

 

Ces résultats correspondent peut-être à une première confirmation de la théorie 
de l’auteur sur les genres h ijāz et h ijāz-kār originels (Beyhom 2007, id.), selon 
laquelle le genre h ijāz, traditionnellement performé sur ré en musique arabe, 
devait à l’origine suivre les degrés DŪKA (ré), SĪKĀ (≈ midb), HIJĀZ (≈ fa#) et 
NAWĀ (sol), et le genre h ijāz-kār (traditionnellement sur do) les degrés RĀST 
(do), ZĪRKULĀ (≈ réb), SĪKĀ (≈ midb) et JAHĀRKĀ (fa).  

 

 
93 La reproduction des pas de temps (ici à 0,1 seconde) s’effectue, dans ce cas, par la commande « Margins > 
Marks top every > (Units = 0.1, Distance = 1) ». 
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Figure n° 24. Genre h ijāz, graphique fréquences/temps sur grille en 17es d’octave 
- Hamdī Makhlūf 94. 

 

La multiplicité des genres h ijāz et hijāz-kār sur des appuis différents (cf. 
Beyhom, 2005) a probablement amené une confusion entre les deux genres qui, 
combinée avec la tendance à leur semi-tonalisation (Beyhom, 2007, op. cit.), 
fait que de nos jours la théorie en est actuellement « perdue » 95, mais que 
l’exécution originelle perdure, comme ici de manière alternée, dans la perfor-
mance 96. 

 

 
94 La reproduction des pas de temps (ici à 0,1 seconde) s’effectue, dans ce cas, par la commande « Margins > 
Marks top every > (Units = 0.1, Distance = 1) ». 
95 Ces descriptions subsistent néanmoins dans des manuscrits arabes du XIXe et XXe siècles. 
96 Soit, en tenant compte de la remarque qui suit dans le texte, un hijāz débutant (en ascendant, lecture 
graphique de droite à gauche à partir du pas de temps « 17 ») par un « petit » intervalle, suivi par un intervalle 
« augmenté » puis par un intervalle « moyen » pour compléter la quarte, et un hijāz-kār débutant (en ascen-
dant) par un intervalle « moyen », suivi d’un intervalle « augmenté » puis d’un « petit » intervalle complétant 
également la quarte. 
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Remarque : les subdivisions en 1 – 4 et 2 multiples de 17es d’octaves pour le genre 
hijāz, par exemple, devraient être relativisées, ces nombres devant être considérés 
comme des repères qualitatifs, plus que quantitatifs : dans ce cadre, il y aurait 4 quali-
tés principales d’intervalles de seconde pour la musique arabe, un « petit » intervalle 
(un « petit » demi-ton, modélisé sur une grille en 17es d’octave comme valant une unité, 
ou « 1 »), un intervalle « moyen » (« 2 » 17es d’octave, soit l’équivalent d’une seconde 
« neutre »), un « grand » intervalle (« 3 » 17es d’octave, soit l’équivalent d’un ton) ainsi 
qu’un intervalle « augmenté » valant approximativement « 4 » 17es d’octave, soit 
l’équivalent approximatif de 5/4 de ton. Cette théorie a l’avantage d’éviter d’utiliser 
l’intervalle de quart de ton (non employé théoriquement, à part des exceptions confir-
mant la règle, cf. Beyhom, 2005) dans les théories arabes de la musique, et de repren-
dre la systématisation d’Urmawī (théoricien de la musique arabe du XIIIe siècle) en 17 
intervalles à l’octave tout en tenant compte de l’aspect zalzalien de l’échelle générale 
arabe. 

Conclusion 
La mesure d’intervalles de musiques monodiques traditionnelles permet, avec 
application de méthodologies relativement simples, de pratiquer des analyses 
d’échelles et de systèmes intervalliques ainsi que de vérifier des courbes 
d’évolution temporelle de degrés (par exemple une fondamentale) ; dans les cas 
plus complexes, cette méthodologie permet, avec un taux d’erreur apprécié à 5 
cents, de suivre les modifications quasi instantanées des intervalles pratiqués, et 
de mieux appréhender la complexité de ces musiques. Nonobstant le fait que les 
quelques analyses proposées dans ce dossier ne font que refléter une sorte 
d’« état des lieux » des recherches propres de l’auteur 97, il devient évident, au 
vu de ces quelques analyses, que la notation « classique » ou « traditionnelle » 
des mélodies de ces musiques ne peut servir que comme un indicateur (très) 
approximatif de la musique réellement performée, des descripteurs supplémen-
taires devant être (ré-)utilisés (évolution de la fondamentale, rétrécissement ou 
élargissement homothétiques ou différenciés des intervalles, variabilité et 
fluctuations de ces derniers, etc.) 98 pour mieux en décrire la complexité. Il en 
ressort également une nécessité de ré-analyser le répertoire enregistré ou vivant 
traditionnel, notamment européen, ce dernier ayant été très probablement assi-

 

 
97 Et dont le but, à travers cette publication, est de contribuer à favoriser l’enseignement systématique de ces 
procédures dans les cours d’ethnomusicologie. 
98 Mais également des analyses avec des divisions asymétriques de l’échelle, ainsi que des procédures de 
corrélation statistique, et de mesures d’écarts-types-moyens, outils que nous n’avons pas pu aborder dans ce 
premier dossier, destiné avant tout à une mise en perspective générale ainsi qu’à une première description par 
l’exemple de méthodologies à suivre pour les mesures d’intervalle. 
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milé à tort par certains « folkloristes » (et leurs successeurs) à un « diatonisme » 
quelque peu approximatif. 
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Annexes 

Annexe I : Tests du logiciel Praat v. 4.0.49 avec des sons générés par les 
logiciels Scala 2.5 et Cool Edit 2.0, ainsi que le clavier arrangeur EM 50 – 
OR (Roland) 
Présentation de Praat 

Praat est un logiciel conçu par des chercheurs de l’université, pour des cher-
cheurs en phonétique. Le terme Praat veut dire « voix » en néerlandais. Ce 
programme est un shareware comportant plusieurs options et une aide en ligne 
complète multi-fenêtre, et a l’avantage d’être ouvert, et non pas une « boîte 
noire » ; la version « testée » est la 4.0.49 99. 

Les départements contributeurs représentés sont des instituts de linguistique, 
d’ortho-rhinologie, de phonétique, de sciences cognitives et de psycholinguisti-
que, ainsi que des institutions universitaires généralistes. Le code est ouvert, les 
sous-programmes supplémentaires peuvent être implémentés, et les valeurs par 
défaut sont toutes modifiables ; les algorithmes utilisés sont disponibles sous la 
forme d’une aide en ligne. 

1er test : avec des sons « purs » générés par le logiciel Cool Edit v 2.0 100 

Les tests sont effectués : 

• sur des sons « parfaits », sans déphasage, 
• sur 4 intervalles égaux en différentiel de fréquence (aliquotes), à 50 Hz 

de distance, étagés de 200 à 400 Hz (une octave), 
• en 3 configurations : son sinusoïdal « pur », son « carré » et son « trian-

gulaire » (figures n° A1 à A3). 

 

 
99 Pour le téléchargement, voir en liste bibliographique. 
100 Disponible dans le commerce. 
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Figures n° A1a/A1b. Son 
sinusoïdal 

Figures n° A2a/A2b. Son 
carré 

 
Figures n° A3a/A3b. Son 
triangulaire 

 

 

 

 

 

 
Figures n° A1a/A1b à A3a/A3b. Sonagrammes et graphiques fréquence/temps 
des trois types de son testés 

• le pas (durée d’un son) choisi est de 0,5 seconde, 
• le test est effectué sur les segments centraux de chaque intervalle (par 

exemple, 1er son de 0 à 0,5 s., test sur 0,1 à 0,4 s., avec moyenne sur le 
segment). 

Les résultats sont exposés en tableau A1, les fréquences étant exprimées en 
Herz et les intervalles en cents : ils montrent que, pour des sons « purs » géné-
rés électroniquement, la réponse du programme dans la plage de 200 à 400 Hz 
(la plus fréquente) est remarquable, la différence maximale se situant à 1,17 
cents pour le calcul de l’octave en son « carré ». Nous déduirons de ce premier 
test que la correspondance « théorique » des mesures d’intervalles par le logi-
ciel Praat est d’ores et déjà avérée. 
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Tableau n° A1. Résultats des tests avec des sons « purs », pistes CD 23 (carré), 
24 (sinusoïdal) et 25 (triangulaire) 

 
Remarquons par ailleurs que les erreurs cumulatives peuvent se pondérer 
(exemple du son carré entre le premier et le deuxième intervalle) ou s’ajouter 
(idem, entre 3e et 4e degrés). 

2e test : avec des sons midi synthétisés 
Les sons ont été générés par le logiciel Scala 2.5 (avec procédure de « pitch 
bend »). 

Trois échelles et deux sons 101 ont été utilisés :  

• une échelle equi-pentatonique, en son piano midi n° 1 (figures n° A4 et 
n° A6), 

• une échelle equi-heptatonique avec le même son (figures n° A4 et n° 
A7), 

 

 
101 Générés par une carte audio sur la carte mère d’un ordinateur PC courant. 
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• une échelle hexatonique en multiples du quart de ton (354354) 102, avec 
un son de clarinette (n° 71, figures n° A5 et n° A8). 

 
Figure n° A4. Sonagramme détaillé du son de piano midi (son Scala n° 1) 

  
Figure n° A5. Sonagramme détaillé du son de clarinette midi (son Scala n° 
71) 

Les mesures ont été effectuées sur des segments stables de chaque degré de 
l’échelle, variables à chaque fois. Les résultats (tableau A2) montrent que les 
erreurs dans les deux cas (intervalles cumulatifs et intervalles différentiels) ne 
dépassent pas 5 %. 

On remarque par ailleurs que les hauteurs nominales, même pour le son de base 
(do à 261,63 Hz), correspondent imparfaitement ; ici, les erreurs de mesure 
(Praat) s’additionnent aux erreurs de génération de son par la procédure midi – 
pitch bend, assez peu précise (Scala). 

 

 

 
102 Soit une échelle ascendante en 3 quarts de ton, puis 5 quarts de ton, puis 4 quarts de ton, etc. 
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Figures n° A6a et A6b. Échelle equi-pentatonique, avec un son de piano (sona-
gramme et graphique fréquences/temps) », piste CD n° 26 

  
Figures n° A7a et A7b. Échelle equi-heptatonique en son piano midi n° 1 (sona-
gramme et graphique fréquences/temps), piste CD n° 27 

 
Figures n° A8a et A8b. Échelle hexatonique en multiples du quart de ton (354354 
– sonagramme et graphique fréquences/temps) avec un son de clarinette, piste 
CD n° 28 

Time (s)
0 15.747

-0.5461

0.493

0
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Tableau n° A2. Résultats des mesures avec des sons midi synthétisés 

 

3e test : avec des sons numérisés générés par un clavier-arrangeur Roland 
EM 50 – OR 
Le son choisi est celui d’un « Nay » ; les segments approximatifs mesurés 
(selon la méthodologie expliquée en corps d’article) sont montrés sur la figure 
n° A9. 
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Figure n° A9. Relevé fréquence/temps d’un son de « Nay » sur arrangeur EM 
OR – 50, piste CD n° 29 

Les résultats (tableau A3) montrent que le différentiel entre les intervalles 
programmés et ceux mesurés par Praat est remarquablement petit (< 5% et, en 
tout état de cause, plus petit que 5 cents). 

La plus grande différence observée (segment n° 2) est due au choix d’un seg-
ment en partie « haute » ; un autre choix de segment (par exemple entre 1,3 et 
1,4 s.) donnerait un résultat plus proche des intervalles annoncés (pour ce 
dernier segment, la fréquence devient 852,46 l’intervalle 91,58 et le différentiel 
1,58 d’où une correspondance remarquable (< 2%). 

Les raisons de ces différences résident très souvent dans le phénomène 
d’attaque (de la note) ou, dans le cas présent, dans les algorithmes de génération 
de sons « altérés » : de là (pour le premier cas) la nécessité de mesurer des 
intervalles entre des segments stabilisés et correctement moyennés.  
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Tableau n° A3. Résultats des mesures avec son de « Nay » sur clavier-arrangeur 
EM OR – 50, piste CD n° 29 (« Nay ») 

 

Conclusions 
Praat est un logiciel de recherche à manipuler avec toutes les précautions 
inhérentes à ce type de programmes informatiques, concernant notamment : 

• le choix des bornes d’analyse de hauteurs, 
• le choix des segments mesurés, 
• et le choix du degré de référence. 

Les résultats des tests effectués semblent démontrer que, en cas d’utilisation par 
un musicologue moyennement compétent et en utilisant les options par défaut 
proposées par le logiciel (et en faisant les choix cités ci-dessus de manière 
judicieuse), l’erreur cumulative sur les intervalles mesurés ne devrait pas dépas-
ser les 5 cents pour des intervalles courants, et devrait en tout état de cause 
rester plus petite que 5 % de l’intervalle considéré. 
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Annexe II : Test (avec Praat v. 4.0.49) de la procédure « stretch » 
(étirement temporel de l’enregistrement) avec maintien des hauteurs 
originelles, pour les deux logiciels Cool Edit v 2.0 et Audacity 1.2.6 
Le test a été effectué sur l’extrait d’un chant interprété par Inés Bacán 103. 
L’extrait a été analysé successivement pour l’original (figure A13), puis pour un 
doublement de la durée sans changement des hauteurs avec le logiciel Cool Edit 
(figure A14), de même pour le logiciel Audacity 104 (figure A15).  

 
Figure n° A10. Original  308,53 Hz à 1,289546 seconde, pas 
de temps de 0,0025 seconde. 

Les graphiques sont éloquents, la forme du relevé changeant dans les deux 
cas 105, avec une différence notable pour la fréquence, ainsi que le rajout de 
« vibrato » dans le deuxième cas (Audacity) ainsi que, dans ce dernier cas, une 
procédure incorrecte d’allongement de la durée de l’extrait (le résultat pour 
l’extrait total est égal à 4.97 secondes, alors que l’extrait original est à 2.579 
secondes) : d’où la nécessité d’utiliser ce genre de procédure avec précaution, 
en ayant au préalable testé les algorithmes du logiciel utilisé, et de prévoir une 
fourchette d’erreur (à déterminer). 

 

 
103 Y a la puerta llaman, 8e morceau, entre 15,786 et 18,368 secondes. Réf. : Inés Bacán, flamenco vivo - 
Soledad Sonora, B6873 - AD 100.  
104 Pour un téléchargement, se référer à la liste bibliographique. 
105 Malgré la précaution prise de doubler le pas temporel d’analyse pour les versions « allongées », leur durée 
(théorique, comme il apparaît sur les résultats) étant le double de celle de l’original. 
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Figure n° A11. Cool Edit  309,58 Hz à 2,579093 se-
condes, pas de temps de 0,005 seconde 106. 

 
Figure n° A12. Audacity  309,93 Hz à 2,485805 se-
condes (longueur totale = 4.971610 secondes), pas de 
temps de 0,005 seconde 107.  

 

 

 
106 Procédure de « stretch » : « Effects > Time/Pitch > Stretch > (“Ratio” = 50, cocher “Time Stretch” et 
“High Precision”, ainsi que “Choose appropriate defaults”) ». 
107 Procédure « Effet > Changer le tempo > (“Pourcentage de modification” = -50) ». 
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